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Background information

There are three Excel workbooks that together comprise Lertap5. They are Lertap5.xlsm,
Lertap5MacroSetA.xlam, and LertapRibbon.xlam. Of these, only Lertap5.xIsm functions as
an “ordinary” Excel workbook, that is, one that can be opened normally, and has work-
sheets with data of one sort or another. This workbook also houses the main Lertap5 code
modules. These modules are referred to as “macros” — they are an extensive, integrated
suite of small computer programs written in “VBA”, Visual Basic for Applications. The
macros in Lertap5.xlsm are invisible to users®. (See an example of a macro here.)

The other two workbooks don’t contain worksheets of any sort. They simply contain mac-
ros, more VBA code. They are entirely subservient to Lertap5.xIsm, that is, they are never

opened directly — they wait to be summoned, something that happens automatically when
the Lertap5.xIsm workbook is opened by a user.

Lertap5MacroSetA.xlam has the special-purpose macros accessed via the “Macs Menu”
from within Lertap5.xIsm. These are “open source” -- users may view them using the Visual
Basic Editor under the “Developer” tab in Excel. (See this reference for more information.)

LertapRibbon.xlam is a special file whose task is to mount the Lertap tab in Excel. As it
opens, Lertap5.xlsm automatically calls this file, asking it to seat the Lertap tab and make it
ready for use.

Now, while you were reading the paragraphs above, | opened Excel on a Windows laptop
running Excel, and then opened the Lertap5.xlsm? workbook. The screen snapshot below
displays what | saw.

1 The most common extension for an Excel workbook is xIsx; xlsm is used when the workbook contains
worksheets and code macros; xlam is used when the workbook has macros only.

2 Many times Lertap5 will display a special message when first opened on a computer, saying something like
having to “intitalise itself”. If this happens, open Lertap5.xIsm once again.


http://www.lertap5.com/HTMLHelp/HTML/index.html?mac_example.htm
http://www.lertap5.com/HTMLHelp/HTML/index.html?macs_menu.htm
http://www.lertap5.com/HTMLHelp/HTML/index.html?lertap5macroseta.htm
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| Welcome to Lertap5

To set up a new workbook, make sure you have the Ribbon
showing, and then use one of the options from the 'New menu'
seen on the Lertap tab. These are the options labelled 'Blank’,
'Headers', and 'Copy'.

To work with data you've already set up, use the File tab to find
and open the relevant workbook. The File tab is at the very top
of this screen, at the very left (close to the apple).

How to use Lertap5? Use the resources available via the 'Help'
option found above, at the bottom right of the Lertap tab, below
the 'License' option.

Email lertap5@gmail.com for assistance.

© 2019, Lertap5.com, all rights reserved

Version 5.11.1, last updated on 1 June 2021.
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Note the various Excel tabs showing in the screen snapshot. There are several of them,
starting with “File” on the left, then “Lertap”, then “Home”, then “Insert”, ..., ending with
llHelpII.

If the Lertap tab does not display after the Lertap5.xIsm workbook has been opened, users
are advised to close the workbook, and then open it again3. If the Lertap tab still does not
display, then it is likely that your copy of Excel has disabled all macros.

As mentioned above, the language used to write Lertap5 macros is “VBA”, Visual Basic for
Applications. VBA macros have something of a bad name — nasty programmers can, and
have, written macros for Excel, Word, OneNote, and PowerPoint that can cause real havoc
with a computer; they might, for example, introduce a virus. For this reason, Excel usually
informs users when a workbook has macros, and asks for an OK confirmation before
continuing.

This is a good idea, but it can at times become tiresome. The three macro-laden Excel
Lertap workbooks mentioned above might each prompt Excel to display its warning
message, and users might then end up having to click OK at least once, sometimes twice
more (particularly on Macintosh computers).

Users have control over how Excel handles macros via “security settings”.

3 |f that fails, then try quitting Excel and begin again.



Changing the Macro Security Setting
The best way to find out how to enable macros on a Windows computer might simply be to
use Bing, Google, or another search engine, and ask “How to enable macros in Excel”.

These days, the majority of Windows users probably have Excel 2016 or Excel 2019 (also

sometimes known as Excel 365). But not everyone; some will have Excel 2013; and some
Excel 2010. If not sure of the version on your computer, search the internet for “How to

determine Excel version number”.

You might also want to read this reference from Microsoft.

Possible errors when opening Lertap5.xIlsm in Windows

Some Windows users of Excel, myself included, have encountered various errors when the
Lertap5.xIsm workbook is opened for the very first time®. They seem to have something to
do with macros, and they also seem to happen just once.

Here is what | suggest: if Excel is open, close it. Then open it again.
Then open Lertap5.xIsm. If a problem of some sort occurs, close Excel. Open it again. Then

open Lertap5.xIsm again and things should be okay. Write to lertap5@gmail.com if help is
needed, but, before doing so, read the next topic:

Delays when opening Lertap5.xIsm in Windows

Starting back in 2018, Excel workbooks with macros, such as Lertap5.xIsm, became subject
to an automatic virus scan from Windows Security. If you’re using Windows (not a Mac),
and, should you find opening Lertap to be slow, noticeably slower than opening other Excel
workbooks, then it might be a good idea to set up a virus scan exclusion as mentioned in

this topic.

Zoom-a-Rama?
When running on some computers, some of Lertap5’s worksheets will, at times, appear to
be almost condensed, and can be hard to read (especially, but not only, on Macintoshes).

It's possible, and easy, to scale up all of the sheets in a workbook, that is, to “zoom” them.
There are two ways to do it.

One way is to let the mouse cursor hover over the name of a worksheet, such as “Freqs”,
and then click the right button on the mouse. A little menu should open up. It will have, at
the bottom, “Select All Sheets”.

4 When opened on a computer for the very first time, Lertap5 may say that it has to “initialize itself” and then
close. Should this happen, simply open Lertap5.xIsm again.
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https://support.office.com/en-us/article/enable-or-disable-macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
mailto:lertap5@gmail.com
http://www.lertap5.com/HTMLHelp/HTML/index.html?antimalware-scan.htm
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Once this little menu is displayed, and “Select All Sheets” is clicked on, the + sign on the
zoom bar at the bottom of the screen can be used to enlarge all of the current worksheets.

That zoom bar at the bottom of the screen, towards the right hand side, looks like this>:

= o + 120%

Another way involves using the setting in Row 57 of Lertap 5’s System worksheet, and then
calling on a special macro to get the job done.

Here’s a snapshot of part of the System worksheet:
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56 (..empty..)

57 Window Zoom setting 130 25 to 200 110
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60 |Automatically output packed plots (for "quintile" plots)? no yes / no no

61 _ Run the plot packer in interactive mode? yes yes / no yes
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The zoom setting is presently set at 130 (%) in this example —it’s found in row 57, column 2.

5> These screen shots are from a Mac; Windows looks pretty much the same.
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http://www.lertap5.com/HTMLHelp/HTML/index.html?systemworksheet.htm

The special macro, “ZoomAllSheets”, is found by going through the Move+ menu, followed
by the MacsMenu, as shown in the next snapshot:
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A click on “ZoomAlISheets” will get Excel to zoom all worksheets to 130% (in this example).
If the setting in row 57 of the System sheet were changed to 115, then the zoom would be
115%.

Read more about using Lertap 5’s special macros by making a cup of coffee or tea, and then
reading this topic.

Help?

Most of the worksheet “reports” made by Lertap5 have a little underlined blue h towards
the right-hand side of row 2 (visible in some of the screen snapshots in this document). This
is a context sensitive hyperlink to “Lelp”, the online help system. Useful. Really useful.

At times a small red triangle will appear in the upper-right corner of a cell. These signal that
a comment is available; the idea is that users can hover their mouse cursor over the cell,
and a comment will appear to help explain the cell’s contents, as exemplified here:
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http://www.lertap5.com/HTMLHelp/HTML/index.html?welcome.htm
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The screen above displays a “Breaks1” report, comparing test results from three American
examination sites, with one from Haiti, and with one from Uruguay. To make the text dark-
er, use <Ctrl><A> to select all of the worksheet’s cells, and then <Ctrl><B> to turn on bold.
(<Ctrl><A> means to hold down the Ctrl and the A keys at the same time.)

If that doesn’t quite do the job you had in mind, click in the cell close to the top of the
screen, on the very left, in the first column, above the first row. It has a triangle in it but is
otherwise empty. Here’s a wee snapshot with the triangle shown in gray, below “Auto-
Save”:
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Clicking in that cell selects all of the worksheet’s cells. After that, <Ctrl><B> will put all text
in bold®.

Being page marked?
At times Excel, after making a fresh “report” worksheet at Lertap5’s bidding, will leave page
break lines on the report. These lines appear as a string of dashes. The screenshot below

gives an example —there’s a vertical line of dashes just after column 11, just before the little
blue h.

6 “Ctrl” refers to the “Control” key. Some keyboards say “Control”, but most just use “Ctrl”.
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http://www.lertap5.com/HTMLHelp/HTML/index.html?breakouts.htm

The dashed line indicates, in this case, that the plots will fit within the width of a printed
page, were you to go ahead and print the results. There are times when a Lertap report will
be too wide for printing in portrait mode and, in such cases, the dashed lines serve to sug-
gest that landscape mode would be better.

1 2 3 4 5 6 7 8 9 10 11
Lertale item responses for score Normal, grouped by Site (4 groups). h
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The dashed lines may be turned off by using the “Page Breaks” option on the little “Excel”
drop-down menu:
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Note where the page break lines are in the plot above. The horizontal dashed line indicates
that this plot will be spread over two pages.



Lertap has a way of controlling the breaks so that this will not happen, something that’s
done by using a “page break control”. The page break control is found in row 92 of the Sys-
tem worksheet. The default setting is “no” — this is because Excel runs noticeably faster
when it doesn’t have to concern itself with page breaks. For more information, refer to this
topic, and to the bottom of this one.

More assistance

Lertap documentation is extensive, covering a manual and no less than four websites. Next
time you’re on an extended flight?, load up your computer or tablet with Lertap5 reference
material (some of it is a bit boring, yes, but certainly not all of it — the manual is something

of a “hoot” in many places, and the boring parts can serve to cure insomnia).

To get to the main website, the gateway to almost all things Lertap5, click here.

Emails may be sent to Lertap5@gmail.com or to l.nelson@curtin.edu.au

7 Flights? As of June 2021 there weren’t many at all in Australian skies thanks to Covid-19.
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